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1. Quick guide for d.velop documents e-
mail integration

1.1. Imprint and legal notices
All previous quick guide documentation for d.3one e-mail integration cease to be valid once this document is published.

The information contained in this documentation has been compiled with the greatest care and checked by our Quality Assurance
department in accordance with the general state of the art. Despite this, errors cannot be ruled out entirely. For this reason, the information
contained in this documentation does not constitute an obligation, promised feature or guarantee. d.velop AG assumes no liability or
warranty on the basis of this documentation. Claims under the German product liability act and tort law shall remain unaffected unless
they have been excluded by individual contract. Statements regarding statutory, legal and tax regulations and their implications are only
valid for the Federal Republic of Germany. d.velop AG reserves the right to replace existing third-party components in its software with
functionally adequate components from other manufacturers. In the exercise of its valid release policy, d.velop AG reserves the right to
no longer support product features and individual software products with software maintenance and support services. You can find more
information about this in the support lifecycle of the d.velop service portal at https://portal.d-velop.de.

The use of texts, images, graphics or their arrangement, including excerpts thereof, is not permitted without the prior consent of d.velop
AG. All hardware and software names used are trade names and/or trademarks of their respective manufacturers/owners, which they have
made available.

If sections of or individual formulations in this documentation do not conform with, no longer comply with or do not fully comply with the
applicable legal position, the remaining parts of the documentation shall remain unaffected in terms of their contents and validity. Within
the documentation, you can navigate via links to external websites that are not operated by us. These links are either clearly marked by us
or can be recognized by a change in the address line of your browser. We are not responsible for the content of these external websites.

Contact d.velop AG Schildarpstraße 6-8 48712 Gescher, Germany

Phone +49 2542 9307-0d-velop.de or info@d-velop.de

Represented by: Sebastian Evers (Co-CEO), Rainer Hehmann (Co-CEO), Dr. Stephan Held (CFO), Christoph Pliete (CAO) Chairman of the
Supervisory Board: Dr. Helmut Bäumer Commercial register: Coesfeld District Court, no. HRB 4903 Sales tax identification number: DE
813062165

If you have any questions about this documentation or the software, please contact us.Tel: +49 2542 9307-6000

support@d-velop.de © d.velop AG. All rights reserved.

This document was last revised on 07/26/2022 and relates to d.3one in Microsoft Outlook version 1.12.0 and d.3one in IBM Notes version
1.12.0..

Name of the document: d3custom_eng.pdf (Build: 20220726)

1.2. Basic information about the quick guide
In this quick guide, you can learn everything you need to know about d.3one integrations in Microsoft
Outlook and HCL Notes (formerly IBM Notes) so that you can get started with d.3one in your e-mail
application immediately.

It will help your understanding if you have a general knowledge of Microsoft Outlook or HCL Notes.

1.2.1. About d.3one
d.3one is an innovative modern product suite with the philosophy of focusing on the end users and
supporting them from wherever they would like to access ECM information, be it Microsoft Outlook,
Microsoft Office, IBM Notes, or simply the browser.

Quick guide for d.velop documents e-mail integration
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Seamless integration and simple handling

You can define a few areas for your users so that they can access the required information with a URL,
without detours and without many clicks.

The innovative search supports you step by step in finding information and data using the facets. In this
way, you also quickly gain an overview when you have large quantities of data. Importing documents into
dossiers is accomplished quickly with drag & drop, whether it is one document or several.

An intelligent check for duplicates protects you from importing identical data multiple times. You can
change document contents and properties at any time. You can also edit contents of Microsoft Office
documents natively and straightforwardly in Microsoft Office.

As a team and across the organization, you communicate directly in d.3one using Tasks and Messages as
well as with integrate forms, so that everyone can participate in digital business processes.

Expandability and adaptation

You can expand and adapt d.3one individually with functions, tailored to your requirements.

d.3one is an innovative tool that allows you to collaborate with the d.3ecm world.

1.3. Getting started
In this section, you can learn about the basic functions in d.3one and the e-mail integrations.

1.3.1. Things to know about searching
In the Search feature, you can find contents in a d.3 repository using key words as well as properties and
categories. To make finding easier, there are a few options available to you that you can combine with
each other or use individually.

You can do the following in the Search feature:

• Select a category or several categories: Use Select category to specify at least a document type or
dossier type to search across. By selecting at least one category, you can find the item more precisely.

• Search by key words: Enter a keyword in the search field. It is a full-text search feature. If you have
selected a category, the search for the keyword is only performed across the selected category.

• Refine results by selecting values in the properties (facets): Enter at least a single value for a property
to use the property for finding documents. You can also combine a category and at least one property.

In the Results section, you will find all the items that match your selected criteria. Each time you add a
property, you can refine the number of results.

In addition to the categories and possible key words, properties are a great help when it comes to
finding. For example, you can search for a specific date or a time period in properties reserved for a date.
You can use properties that contain only figures such as monetary amounts to find documents located in
a certain figure range or whose values are larger or smaller.

1.3.2. Finding items based on properties and categories
The Search feature helps you find data and information even if you do not exactly know where and how
to search for it. You do not need any special knowledge about the dossier and document structure in the
d.3 repository. You can simply search for a keyword or a category and, then, restrict the search result by
additional traits (facets) until you get the information you need.

In a sense, you are rummaging in a pool data and information based on a vague idea that there is
information that you need for your task.

Quick guide for d.velop documents e-mail integration
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Supposed, you only know the category and want to learn more about a specific customer. Although you
know the name of the category, e.g. Customer invoice/credit, you have only a vague memory of other
details, such as the customer number and when changes were made.

This is how it works

1. Select at least one category in the start section under Select a category. The category is added to
the bouquet.

2. The properties are immediately reduced to the values which are found based on the keyword you
entered. If you specified several categories, all properties are shown that are commonly existing in
the specified categories.

3. Select a property to add this to the bouquet.
4. Perform the search to display the results for the indicated criteria.
5. Indicate further properties to refine the search result.

If you want to remove properties from the bouquet, click or tap on the cross next to the property.

1.3.3. Finding contents using keywords
The Search feature helps you find data and information even if you do not exactly know where and how
to search for it. You do not need any special knowledge about the dossier and document structure in the
d.3 repository. You can simply search for a keyword or a category and, then, restrict the search result by
additional traits (facets) until you get the information you need.

In a sense, you are rummaging in a pool data and information based on a vague idea that there is
information that you need for your task.

In addition to the search using categories and properties, you also have the option of searching for
items using key words in the full-text search. This search option is only available if the full-text search
functionality was installed for your organization.

Suppose you know that there are projects and documentations related to the topic "ebikes" in your
organization. Maybe the keyword exists in a document and is also mentioned in the properties of a
document. You can enter the keyword "ebikes" into the search field. Because the result list is very long,
you can specify additional properties.

This is how it works

1. Enter a keyword into the search field.
2. The properties are immediately reduced to the values which are found based on the keyword you

entered.
3. Select a property to continue to refine the result.

The found keyword is only displayed in the result list if it matches the selected properties.

1.3.4. Refining searches using facets
The Search feature helps you find data and information even if you do not exactly know where and how
to search for it. You do not need any special knowledge about the dossier and document structure in the
d.3 repository. You can simply search for a keyword or a category and, then, restrict the search result by
additional traits (facets) until you get the information you need.

In a sense, you are rummaging in a pool data and information based on a vague idea that there is
information that you need for your task.

For example, if you use a keyword for your search operation, you may get a lot of results. Since
the keyword only exist in certain categories and properties, the properties are reduced based on the
results. Only those properties are shown that are present in the result list. You can refine the results by
specifying more properties.

Quick guide for d.velop documents e-mail integration
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Let's suppose you want to know who is currently working on an essential project. The data about each
project are collected in a project dossier in the d.3 repository. A common property of all documents in
the project dossier is the name of the project manager. You can select the category Project dossier so
that the search result is refined for the first time using this facet. You can refine your search result again
because you now get only the names in the project manager name property that are actually listed as
project manager in the properties of the result.

The Search feature uses the opposite approach. The opposite approach to finding information is made
possible by the full-text search functionality on the one hand and due to faceting the search operation.

With the faceting feature, you are offered only the search criteria (properties and categories) that always
lead to a result.

This combination of functions helps you get the information you need faster and more efficiently.

• The pre-selection makes the difference: For each search result you only get the properties that are
actually present in this search result and, thus, can be selected.

• The combination of criteria leads to where you want to go: The search criteria present in the search
result facilitate your search because you can only select from the criteria that are relevant and present
in your search. This means that any values which were excluded previously by the selected search
criteria are no longer present.

• The search operation always ends up with results: Use the offered properties and categories for
your search to ensure that you always get results. You can immediately refine the result by adding or
removing search criteria.

1.3.5. Storing documents
Use the Storage feature to save files in your d.3 repository.

Suppose you would like to save a locally saved file in your repository.

This is how it works

1. Click or tap Storage on the start page.
2. In the start section Store in, you can specify a file using Browse and select a category, in which you

want to save the file in the d.3 repository.
3. You can specify the properties in the Advanced perspectives which are valid only for this category.
4. If your category contains multi-values, enter the values in the Multi-value perspective.
5. You can specify the common, system-specific properties in the Common perspective.
6. Confirm saving the item with Save.

Once you have successfully saved the item, you can use the context action Save new document to
directly save an additional item in the repository. To display the saved item once the storage process is
finished, use the context action Show document. This context action is used to display the detail section
with the perspectives of the document.

Characteristics about the document number

The document number is a common property available for any document. If you store a document which
already exists in a d.3 repository, you can enter the document number to match the document. You
can identify an already existing document in the repository by using the document number in order to
update the existing document or to create a new version of the document. If there is already a document
existing in the same category with the identical document number and variant number, you switch to
the update mode. Once you switch, the properties of the existing document are already specified and
displayed. If you have already entered changed the properties, the values are discarded.

Each document has a certain status. If the existing document is in the status Release or Archive, you
create a new version of the document with Save. The existing document is replaced if it is available in
the status Processing and Verification.

Quick guide for d.velop documents e-mail integration
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1.3.6. Storing e-mails using the "Store e-mail" context menu
You can store at least one e-mail in a d.3 repository using the Store e-mail context menu.

This is how it works

1. Select at least one e-mail in your mailbox and open the context menu.
2. Choose Store e-mail, or Store e-mails if there are several.
3. Enter the properties required for each e-mail in the Storage feature.
4. Save the e-mail in the d.3 repository.

1.3.7. Storing attachments using the "Store attachments" context menu
You can store attachments from a selected e-mail separately in a d.3 repository.

This is how it works

1. Select an e-mail with an attachment in your mailbox and open the context menu.
2. Choose Store attachment, or Store all attachments if there are several.
3. Enter the properties required for each attachment in the Storage feature.
4. Save the item in the d.3 repository.

1.4. More functions and settings
In this section, you can find additional functions to help you with your daily work with your e-mail
application.

1.4.1. Manual saving of items in dossiers
You can store at least one item (file, e-mail) in a dossier by dragging it onto the desired dossier in the
dossier navigation or in the result list of the search and dropping it in the Save manually area. When
saving manually, you can select another category than the default category of the dossier and specify the
properties individually.

Suppose you would like to save several local files in a dossier and indicate the document properties
manually.

This is how it works

1. Drag the items onto a dossier in the Save manually area.
2. Select the category for the first item and enter the required values for the properties. If a default

category has been defined for the dossier, this category is automatically selected for all items.
3. Click on Next and enter the values for the following items. The category selected for the first item is

suggested for all other items. If necessary, you can change the category for each item.
4. Click on Back or Next to check your entries again or to make changes.
5. In the summary of the documents to be saved, choose whether all the items are to be saved. If you

do not want to save an item in your repository, click on Do not save.
6. Click on Apply to save all items with the indicated properties.

If at least one item could not be saved successfully, you will see a notification and you can edit the item
again. You can get to the related storage dialog by moving back page by page with Back or use the pencil
icon to navigate directly to the according page.

1.4.2. Automatic saving of documents in dossiers
You can store at least one item (file, e-mail) in a dossier by dragging it onto a dossier in the dossier
navigation or in the result list of the search and dropping it in the Save automatically drop zone.

The options to store an item are set up by a d.3 administrator and depend on your permissions.

Quick guide for d.velop documents e-mail integration
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When you drag an item onto the drop zone Save automatically, the name of the category is shown that
was configured as the default category of the dossier. You save the item in these categories.

Once you have dropped the item, a dialog is displayed to inform you that the item is transmitted to the
server. If you dropped several items onto the dossier, the respective status and the related note is shown
for each item. If, for example, properties required by the dossier or the item to be stored could not be
applied, you are forwarded to the section in which you can store it manually.

1.4.3. Storing e-mails using the "Store e-mail in" context menu
You can use the Store e-mail in function to store one or more e-mails directly in their appropriate
category in a d.3 repository.

To enable you to save your e-mails more quickly and easily, your administrator must define categories for
the Store e-mail in function.

This is how it works

1. Select at least one item in your mailbox and open the context menu.
2. Choose Store e-mail in and then select the appropriate category.
3. Enter the properties required.
4. Save the e-mail in the d.3 repository.

1.4.4. Storing e-mails using the "Store e-mail in" context menu
If you want to send an e-mail with attachments, you can send the e-mail and save it in a d.3 repository in
the same step.

Let's assume you have opened a finished e-mail with attachments and you now want to send and store
this e-mail.

This is how it works

1. Open the context menu and choose Send e-mail and store in d.3 repository.
2. Select an appropriate category in the Storage feature.
3. Enter the required properties and store the e-mail.

1.4.5. Simultaneously sending and saving e-mails and attachments in Microsoft
Outlook
If you want to send an e-mail with attachments, you can send the e-mail and save it in a d.3 repository in
the same step.

The Send and store function works properly only if you store the sent items in the Sent Items folder in
Microsoft Outlook.

Let's assume you have opened a finished e-mail with attachments and you now want to send and store
this e-mail.

This is how it works

1. On the Microsoft Outlook menu ribbon for the e-mail, choose Send and store.
2. Select an appropriate category in the Storage feature.
3. Enter the required properties and store the e-mail.

1.4.6. Context-sensitive search for selected content
You can search for keywords simply and quickly using an e-mail. Your administrator must define key-
words for the Search for function to enable you to search for the appropriate customer record for an
e-mail directly in the d.3 repository, for example.

Quick guide for d.velop documents e-mail integration
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Let's assume you receive an invoice by e-mail and you want to use the invoice number to check whether
a customer record already exists for this customer in your d.3 repository. Your administrator has set up
the Search for function so that you can search for the customer record directly.

This is how it works

1. Select the relevant e-mail.
2. Open the context menu and choose Search for.
3. Select the relevant entry to search for the customer record in the d.3 repository.

1.4.7. Searching for the sender of an e-mail
You can use the Search for function to search for the sender of an e-mail directly in your d.3 repository.
Your administrator must define keywords for the Search for function to enable you to check whether
additional items for this name exist in your d.3 repository, for example.

For e-mails from external senders, you must search for the complete e-mail address (e.g. john.doe@<do-
main name>). For e-mails from internal senders, you can also search for the name (e.g. "John Doe").

1.4.8. Opening a different application with the "Go to" context menu
You can use an e-mail to open content quickly and easily in a different application (e.g. your ERP
system). Your administrator must define keywords for the Go to function to enable you to switch to the
appropriate application.

Let's assume your administrator has defined a Go to function for you that enables you to switch directly
to the appropriate process in your ERP system.

This is how it works

1. Select the relevant e-mail.
2. Open the context menu and choose Go to.
3. Select the relevant entry to open your ERP system.

1.4.9. Restoring an item from a d.3 repository
You can restore individual documents or e-mails that were archived previously using the Restore from
repository context menu. The item is restored in the background. You can continue working with your
e-mail application.

Depending on the size of the item, the restore process can take a number of seconds. When you restore
larger files, you may not receive the usual feedback about the restore. However, the file is still restored.

1.5. Tips and tricks
You can find out more about tips on functions and tips for making your work easier in this section.

1.5.1. Sending an item by e-mail as an original file or PDF file
For example, you can send documents from your result list directly as attachments in a new e-mail.

Let's assume that you have found the original file for an invoice using the Search feature and you now
want to send it to an employee by e-mail.

This is how it works

1. Select the item in the result list.
2. Click the context action Send as e-mail.

If a PDF file for the selected document exists, you can also use the context action Send as PDF.

Quick guide for d.velop documents e-mail integration
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1.5.2. Replacing attachments in the mailbox with HTTP links
When you store an e-mail in a d.3 repository, you can save memory space in your mailbox by replacing
the e-mail attachments with HTTP links after storing them. Attachments are not replaced with links by
default. However, you can specify that attachments are to be replaced with links under Post-processing
options.

You can display the archived e-mail and attachments at any time by clicking the link in the e-mail.

1.5.3. Defining the settings for integration in Microsoft Outlook
To make your daily work with your e-mail application easier, you can adjust the behavior of your
application to your requirements. Multiple options are available to you.

Let's assume that you receive a large number of approval workflows in your mailbox. You can configure
the settings so that the workflows are opened directly from the browser.

If, for example, you frequently search for e-mails in the d.3 repository, you can also define the Search
feature as a start page.

This is how it works

1. On the Microsoft Outlook menu ribbon, choose File and then Options.
2. In the Outlook Options dialog box, click Add-ins > Add-in Options.
3. Activate the checkbox Open workflow instead of e-mail message.
4. Choose In new window, for example, to open workflows directly in the browser.
5. Under Select starting application, for example, select the entry Search and confirm your settings.
6. Restart Microsoft Outlook.

1.5.4. Defining the settings for integration in HCL Notes
To make your daily work with your e-mail application easier, you can adjust the behavior of your
application to your requirements. Multiple options are available to you.

Let's assume that you receive a large number of approval workflows in your mailbox. You can configure
the settings so that the workflows are opened directly from the browser.

If, for example, you frequently search for e-mails in the d.3 repository, you can also define the Search
feature as a start page.

This is how it works

1. Choose File > Preferences.
2. In the User Preferences dialog box, select the entry d.3one.
3. Activate the checkbox Open workflows directly from e-mail messages.
4. Choose In new window, for example, to open workflows directly in the browser.
5. Under Select starting application, for example, select the entry Search and confirm your settings.
6. Restart HCL Notes.

1.5.5. Defining the maximum age of documents to be saved locally in HCL Notes
If you are often away on business, for example, it is useful to store archived e-mails locally on your
mobile device. You can then access your e-mails even if you do not have an internet connection.

If you want to save archived e-mails locally, you can also save only items from within a specific time
period. The date on which the items are received or sent is used to calculate the period.

This is how it works

1. Choose File > Preferences.

Quick guide for d.velop documents e-mail integration
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2. In the User Preferences dialog box, select the entry d.3one.
3. Activate the Offline Store.
4. Enter the relevant value under Synchronize documents of the previous x days and confirm your

settings.

1.5.6. Defining the maximum age of documents to be saved locally In Microsoft
Outlook
If you are often away on business, for example, it is useful to store archived e-mails locally on your
mobile device. You can then access your e-mails even if you do not have an internet connection.

If you want to save archived e-mails locally, you can also save only items from within a specific time
period. The date on which the items are received or sent is used to calculate the period.

This is how it works

1. On the Microsoft Outlook menu ribbon, choose File and then Options.
2. In the Outlook Options dialog box, click Add-ins > Add-in Options.
3. Choose Offline Store configuration for d.3one.
4. Activate the Offline Store.
5. Enter the appropriate value under Save items offline that are not older than (days).
6. Restart Microsoft Outlook.

1.5.7. Reserving disk space on the local data medium
You can reserve free storage space for the local disk to prevent the storage space from being occupied
by the Offline Store. Once the reserved storage limit (MB) is reached, synchronization stops automatical-
ly.

Let’s assume you want to reserve 10240 MB on the local disk

This is how it works

1. On the Microsoft Outlook menu ribbon, choose File and then Options.
2. In the Outlook Options dialog box, click Add-ins > Add-in Options.
3. Choose Offline Store configuration for d.3one.
4. Under Preserved disk space (MB), select the value 10240.
5. Restart Microsoft Outlook.

1.5.8. Excluding Microsoft Outlook folders from synchronization
You can specify Microsoft Outlook folders that are not to be synchronized. All Microsoft Outlook folders
are synchronized by default.

You can also exclude folders using macros. If you have any questions about macros, please contact your
administrator.

Let's assume that you want to exclude the Microsoft Outlook Junk E-mail folder from synchronization.

This is how it works

1. On the Microsoft Outlook menu ribbon, choose File and then Options.
2. In the Outlook Options dialog box, click Add-ins > Add-in Options.
3. Choose Offline Store configuration for d.3one.
4. Under Exclude Folders, select the folder Junk E-mail.
5. Restart Microsoft Outlook.

Quick guide for d.velop documents e-mail integration
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1.5.9. Displaying d.3 items in the Microsoft Outlook reading area
You can display d.3 items directly in the Microsoft Outlook reading area to complete your tasks more
quickly.

The d.3 items are provided for you as d.velop documents links in an e-mail. When you click the link, the
content is displayed in the reading area.

If you double-click the e-mail, you can see the document in the reading area of the application. You can
start your task as usual, for example, using the Start editing context action.

To display d.3 items in the reading area, activate the add-in option Open workflow instead of e-mail
message in the Microsoft Outlook options and choose the option In Microsoft Outlook.

1.5.10. Hiding the d.3one integration in Microsoft Outlook
You want a full view of your inbox in Microsoft Outlook. However, if you are working with a mobile
device, for example, the space on the screen is limited. You can then permanently hide the d.velop
documents integration.

This is how it works

1. On the Microsoft Outlook menu ribbon, go to the View tab.
2. In the d.3ecm area, deactivate the Show checkbox to hide the integration completely.
3. Restart Microsoft Outlook.

1.6. Frequently asked questions
You can find answers to frequently asked questions in this section.

1.6.1. Why doesn't the synchronization of my e-mails in Microsoft Outlook work
anymore?
If your PC or mobile device is in offline mode, you can continue working with the e-mails in the Offline
Store. Offline Store synchronization stops after 60 seconds at the latest. If you switch back to online
mode, the synchronization process starts again.

1.6.2. Why can't I use the "Send and store" function in the Microsoft Outlook
reading area?
You can display, edit and send e-mails in the Microsoft Outlook reading area. However, you can only
access the Send and store function on the menu ribbon of the opened e-mail.

1.6.3. Why can't I store an e-mail with large files?
You can use the d.velop documents integration to store e-mails with a size of up to 50 MB. When you
store larger files, you may not receive the usual feedback about the storage or individual items of the
e-mail may not be processed correctly.

1.6.4. Why can't I archive e-mail attachments? in Microsoft Outlook?
To be able to archive e-mail attachments, you must check whether certain security settings in Microsoft
Outlook are deactivated.

If you have any questions about the security settings, please contact your administrator.

This is how it works

1. Click File on the menu ribbon and then choose Options.
2. Click Trust Center > Trust Center Settings.
3. Click Attachment Handling and ensure that the Turn off Attachment Preview checkbox is deactiva-

ted.
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1.6.5. Why can't I store e-mails from my Microsoft Outlook outbox in the d.3
repository?
You cannot store e-mails in the d.3 repository if they are located in the Microsoft Outlook Outbox folder.

1.6.6. Why is the "Replace attachments" option not displayed in Microsoft Outlook
when I save RTF e-mails?
In Microsoft Outlook, attachments from e-mails in Rich Text Format (RTF) cannot be replaced with HTTP
links.

1.6.7. Why is the "Replace attachment" option not displayed when I save signed or
encrypted attachments in MIME format in HCL Notes?
In HCL Notes, signed attachments in MIME format and encrypted attachments in MIME format cannot
be replaced by HTTP links.

1.6.8. Why is the "Go to" function not displayed in some e-mails?
You can only use the Go to function to open the contents of an e-mail in your ERP system, for example,
if the e-mail contains information that meets the criteria of the Go to function.

If, for example, your administrator has defined a Go to function for invoice numbers, the e-mail in
question must also contain an invoice number (in the e-mail subject line or text, for instance).

1.6.9. Why is the "Search for" function not displayed in some e-mails?
You can only use the Search for function to open the contents of an e-mail in the repository if the e-mail
contains information that meets the criteria of the Search for function.

If, for example, your administrator has defined a Search for function for invoice numbers, the e-mail in
question must also contain an invoice number (in the e-mail subject line or text, for instance).

1.6.10. What do the e-mail icons in HCL Notes mean?
You can use the icons shown directly on an e-mail to identify whether the e-mails or their attachments
have been stored in a d.3 repository and much more:

The icon with the blue envelope means that the e-mail has been stored in a d.3 repository.

The icon with the blue parentheses means that the attachment in an e-mail has been stored in a d.3
repository.

The blue link icon means that the e-mail has been stored in a d.3 repository and the attachment in the
e-mail has been replaced by a link.

The icon with the green envelope means that the e-mail has been restored from a d.3 repository.

1.6.11. What do the e-mail icons in Microsoft Outlook mean?
You can use the icons that are shown directly on an e-mail to identify whether the e-mail or its
attachments have been stored in a d.3 repository and much more:

•  The e-mail has been stored unread in a d.3 repository.
•  The e-mail has been read and stored in a d.3 repository.
•  The e-mail has been read, forwarded and stored in a d.3 repository.
•  The e-mail has been read, responded to and stored in a d.3 repository.
•  The e-mail has been read. The e-mail attachment has been stored in a d.3 repository.
•  The e-mail has been read and forwarded. The e-mail attachment has been stored in a d.3 repository.
•  The e-mail has been read and responded to. The e-mail attachment has been stored in a d.3

repository.
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•  The e-mail has not been read. The e-mail attachment has been stored in a d.3 repository.

1.6.12. What do the parentheses after some "Search for" functions mean?
If you have access to more than one d.3 repository, the name of the relevant repository is displayed next
to the search term in the context menu for the Search for function.

1.6.13. What is a context action?
Context actions are functions which are only available to you if the function is useful in this specific con-
text. For example, you can download documents to your local disk, thus, in the context of a document
in the result list, you can find the function for downloading items. However, dossiers are a kind of sleeve
(logical parenthesis) around documents in the real world as well. For your work purposes, the documents
are of importance, while the ring binder is a means to thematically bundle documents. Thus, it does not
make sense to offer the download function for a dossier in the digital world.

You can only see the context action if you can use the function. The advantage is that the user interface
is easy to oversee and clearly structured. You can decide more quickly what to do because the number of
options is customized according to the context.

You can find the context actions for a selected item positioned laterally at the screen margin. By default,
the context actions are displayed as icons. Point to the icon using the mouse, the function is displayed as
text. Use the double-headed arrow to display the context action with the text or part of the text so that
you can identify the icons more quickly.

The context actions for an item are combined in a menu for context actions so that you can directly
perform the actions for an item. You can tell the menu for context actions by the three superimposed
dots.

The context actions which are only present in an integrating application, e.g. in Microsoft Outlook, are
not available in the menu for context actions.

1.6.14. If I change an archived e-mail in Microsoft Outlook, which changes are
retained when I restore it?
If the attachments in archived e-mails were replaced by HTML links, the following applies when they are
permanently restored:

• If you changed the text of an e-mail after archiving it, your changes to the text are retained when you
restore it.

• If you removed the attachments after archiving the e-mail, the attachments are restored from the
repository when you restore the e-mail.

1.6.15. How do I activate d.3one functions in Microsoft Outlook?
By default, you can access the d.3one functions as soon as your administrator has provided you with the
add-in.

If the add-in is not displayed automatically, enable the add-in.
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This is how it works

1. On the Microsoft Outlook menu ribbon, choose File and then Options.
2. In the Outlook Options dialog box, click Add-ins.
3. Select the entry COM Add-ins.
4. Activate the d.3one checkbox.

1.6.16. How can I store an encrypted e-mail from HCL Notes in a repository?
Although you can decrypt an e-mail that is to be saved, the e-mail is stored encrypted in the d.3
repository.

You cannot store attachments from encrypted e-mails. However, you can store the whole e-mail.

1.6.17. How can I store an encrypted e-mail from Microsoft Outlook in a reposito-
ry?
Although you can decrypt an e-mail that is to be saved, the e-mail is stored encrypted in the d.3
repository.

You cannot store attachments from encrypted or signed e-mails. However, you can store the whole
e-mail.

1.6.18. How can I accept a certificate that was previously rejected in HCL Notes
again?
If you do not confirm that the certificate is trusted while downloading a document, an error message
is always displayed when you navigate to d.3one. The rejection of the certificate means that the entire
communication is no longer trusted.

Restart HCL Notes and repeat the process that led to the certificate message. Confirm the trustworthi-
ness of the certificate. If you have any questions about the certificate, please contact your administrator.

1.6.19. How often are e-mails synchronized in the Offline Store?
When you are online, e-mails are synchronized every hour in the Offline Store. If the synchronization
takes longer than one hour, it starts again immediately.

The Offline Store is automatically "cleaned" prior to each synchronization: For example, if you change
your settings or if items exceed their maximum permitted age, these items are deleted from the Offline
Store before each synchronization.

1.6.20. How often are e-mails synchronized in the Offline Store?
You can display the d.3 properties of an e-mail that was previously archived or restored.

This is how it works

1. Select the relevant item in your mailbox and open the context menu.
2. In the context menu, select the entry Show in d.3one.
3. If necessary, go to the Properties perspective.

1.6.21. Where can I find detailed information about e-mail synchronization in
Microsoft Outlook?
Where necessary, you can view detailed information about the last synchronization, the current capacity
of the Offline Store and the time of the next synchronization. You can find the information by clicking
the three dots under d.3one Offline Store in the Microsoft Outlook navigation pane.
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